
Doc No.   :PT-HMOC-OPS-FOP-6001-OPS-OAH
Fop Issue :                         3.0
Issue Date:                    13/04/10

  Patch HIFI DPU OBS in instrument Intermediate mod e

  File: H_FCP_OBS_3111.xls
  Author: lstefanov-hpLiviu Stefanov

This Herschel OBSM nominal procedure is used to pat ch the HIFI 
OBS in instrument Intermediate mode (OBS patch from  Application 
SW). It is called by the FOP HIFI procedure H_FCP_H IF_CPOM.
The patches are loaded into the HIFI DPU PM-High me mory and the 
image integrity after upload is checked via checksu m calculation 
and verification. The OBS image is copied from PM-L ow to PM-High 
by the calling procedure, before starting the patch  upload.

The copying of the OBS image from PM-High to PM-Low  and OBS 
restart is executed in the calling procedure H_FCP_ HIF_CPOM.
The calling procedure also includes the PM-High OBS  image 
checksum verification and the updated OBS patch num ber 
verification.

This procedure assumes that the memory load and mem ory check 
command stacks have already been generated using th e OBSM system 
and are ready for loading on the Manual Stack. The command stack 
generation activity is not covered by this procedur e.

Note: H_FCP_OBS_3110 can be used for the full uploa d of the HIFI 
DPU OBS from ASW. 

CDMU in Operational Mode
- HIFI in Intermediate mode (ASW running)

Memory areas are Loaded through TC(6,2) and Checked  through 
TC(6,9); this TC will be delayed when there is an o ngoing:
- TC(6,2) Load Memory Using Absolute Addresses
- TC(6,5) Dump Memory Using Absolute Addresses
- TC(6,9) Check Memory Using Absolute Addresses
- TC(8,4,1,1) Copy Memory

Start of Procedure

CDMU in Operational Mode
- HIFI in Intermediate mode (ASW running)

End of Procedure

Same as start except:
- New HIFI OBS image loaded in DPU PM-High memory

Input Command Sequences

Output Command Sequences

OFCP3111        

Procedure Summary

Objectives

Summary of Constraints

Referenced Displays

Reference File(s)

Spacecraft Configuration

e
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Procedure Summary

e

ANDs GRDs SLDs
HA070289    

DATE FOP ISSUE VERSION MODIFICATION DESCRIPTION AUTHOR SPR REF

 30/01/08   1 1 Created  lstefanov-hp    

 16/06/09     2

1. added current steps 2 and 3, with sub-steps, to dump the HIFI OBS image from PM-
Low before patch�
2. step 4 and sub-steps updated to separate patch stack load from check stack load and 
stack load for Prime and Redundant�
3. added current step 6 to separate check stack load from patch stack load�
4. current steps 6 and 7 and sub-steps updated for verification via checksums of the whole 
OBS image in PM-High, as advised by Luc Dubbeldam in e-mail from 11/06/2009�
5. added current step 8 to include return to calling procedure and instruct for OBS image 
dump from PM-Low  lstefanov-hp    

 08/09/09   2.5 3

1. step 2.3 and substeps updated for OBS image dump from PM-High and exclusion of 
the runtime header memory area from OBSM Monitor/Comparison, as advised by Luc 
Dubbeldam in e-mail from 23/06/2009�
2. step 3.5 updated for "Image UPDATE" instead of "Image MONITOR"�
3. step 4.3 updated to instruct the operator to always patch ("Must be Patched" in CT) the 
runtime header memory area with the values in the latest OBSM Reference Image and 
skip the patching of the inter-segment memory area, filled with zeroes - as advised by Luc 
Dubbeldam in e-mail from 23/06/2009�
4. steps 6.3 and 7 with sub-steps updated to reflect the checksum verification strategy 
([0x00-0xFF]+0x3FFFF and [0x4000-EOF]+0x3FFFF) suggested by Luc Dubbeldam in e-
mail from 23/06/2009  lstefanov-hp    

Configuration Control Information
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Step 
No. Time Activity/Remarks TC/TLM Display/ Branch AIT Comment

Beginning of Procedure

OFCP3111
TC Seq. Name :OFCP3111 (  )
Patch HIFI OBS from ASW and check image

TimeTag Type:  B
Sub Schedule ID: 

 �

 1      Verify initial conditions

 

 Next Step:
  2

Check HIFI instrument in Intermediate mode (ASW 
running)

 

Instrument SOE to confirm HIFI instrument mode  

Note:
Initial conditions are verified in calling procedur e 
H_FCP_HIF_CLOM.

 

 

 2      Manual Stack manipulation
Load command stack file for HIFI DPU current OBS du mp 
on Manual Stack

 

 Next Step:
  3

NOTE:
The current procedure assumes that the memory dump in 
Live mode is performed using commands with immediat e 
execution.

 

Select the File -> LoadStack option from the main 
menu of the Manual Stack window

 

 

 2.1    IF
HIFI Prime

 

   

Select file

HIDPRMPG_DI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/HIDPRMPG

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

HIDPRMPG_DI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

e
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 2.2    ELSE
HIFI Redundant

 

   

Select file

HIDPRMPR_DI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/HIDPRMPR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

HIDPRMPR_DI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 2.3    Check memory dump command stack loaded 

 

   

Note:
The HIFI DPU OBS image is dumped from the PM-High area

 

Note:
The HIFI OBS image delivered in ICD-14 format consi sts 
of one block.
The block contains three segments:

- the runtime header starts at 0x00, length= 0x100
- the init-segemnt starts at 0x4000
- the PM-code segment.

The regions between segments are filled with 0x00.

 

IMPORTANT:
The runtime header in PM-Low changes continuously.

A memory model (CT) shall be used to exclude this 
memory area from OBSM Image Monitor or Image Compar e 
against an OBSM Base Image.

 

For HIFI OBS v.6.2.1:

Start Address = 03.FFFF hex
End Address   = 05.852A hex
Length        = 1852C hex

 

IMPORTANT:
# of TCs, Address and Length values in the following 
sub-steps are applicable to HIFI OBS v.6.1.2

 

Note:
The ' Length' parameter of the memory dump command is a 
16-bit long parameter. A memory dump TC can cover a  
number of 65535 dec ( FFFF hex) SAUs.
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e

 2.3.1  Check number of memory dump commands in the  stack

 

   

Check that loaded stack contains:
   2 TCs XC005998

 

 

 2.3.2  Check Memory ID

 

   

Display the Manual Stack in 'Full mode' and check t hat 
the Memory ID parameter in the XC005998 commands is 
set to 00 hex:

Memory ID = 00 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  HIFI Memory Dump

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Dump HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC005998

00xx <hex>  
 <hex> (Def)
 <hex> (Def)

TC  

 

 2.3.3  Check start address and length of first com mand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address and Length in the first XC005998 command:

Start Address = 03.FFFF hex
Length        = FFFF hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Page 6 of 21
Status      : Version 3 - Unchanged
Last Checkin: 08/09/09 



Doc No.   :PT-HMOC-OPS-FOP-6001-OPS-OAH
Fop Issue :                         3.0
Issue Date:                    13/04/10

  Patch HIFI DPU OBS in instrument Intermediate mod e

  File: H_FCP_OBS_3111.xls

  Author: lstefanov-hp

Step 
No. Time Activity/Remarks TC/TLM Display/ Branch AIT Comment

e

Execute Telecommand
                                  HIFI Memory Dump

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Dump HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC005998

0003 <hex> 
FFFF <hex> 
FFFF <hex> 

TC  

 

 2.3.4  Check start address and length of second co mmand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address and Length in the second XC005998 command:

Start Address = 04.FFFE hex
Length        = 852D hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  HIFI Memory Dump

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Dump HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC005998

0004 <hex> 
FFFE <hex> 
852D <hex> 

TC  

 

 3      Dump HIFI DPU current OBS image

 

 Next Step:
  4

Note:
The HIFI DPU OBS image is dumped from the PM-High area

 

 

 3.1    MCS OBSM preparation for Image update in LI VE mode

 

   

Note:
It is assumed that the OBSM application is already 
running and the OBSM Desktop is displayed on the MC S 
client.
Starting the OBSM application is not covered by the  
current procedure.
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 3.1.1  Select 'Image UPDATE' from the menu

 

   

Select the Image menu of the OBSM Desktop .

From the Image menu, select Update. 

The 'Image Catalog' window opens.

 

 

 3.1.2  Select image to be updated

 

   

 

 
3.1.2.1

 IF
HIFI Prime

 

   

Select the image to be updated for the memory devic e 
HIDPRMPG.

The 'Image UPDATE' window opens.

 

 

 
3.1.2.2

 ELSE
HIFI Redundant

 

   

Select the image to be updated for the memory devic e 
HIDPRMPR.

The 'Image UPDATE' window opens.

 

 

 3.1.3  Start dump TM processing

 

   

In LIVE mode, processing of incoming real-time 
telemetry starts automatically after the image 
selection.

 

 

 3.2    Upload commands to dump the HIFI DPU curren t OBS 
image

 

   

Uplink the XC005998 memory dump commands with ARM-GO  

For each command, several TM(6,6) packets must be 
received on ground.

 

 

 3.3    Verify reception of TM(6,6)

 

   

Note:
One or more TM(6,6) packets will be received for ea ch 
memory dump command uplinked.
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 3.3.1  IF
HIFI Prime

 

   

Verify Packet Reception

HIFI_memory_dump
Packet Mnemonic :        H_mem_dump
APID :                   1024
Type :                   6
Subtype :                6
PI1 :                    
PI2 :                    
 

 3.3.2  ELSE
HIFI Redundant

 

   

Verify Packet Reception

HIFI_R_memory_dump
Packet Mnemonic :        H_mem_dump
APID :                   1025
Type :                   6
Subtype :                6
PI1 :                    
PI2 :                    
 

 3.4    Check OBSM dump packet processing

 

   

Check that the OBSM is processing the incoming memo ry 
dump packets.

 

 

 3.5    Save merged image

 

   

Save merged image with new ID.  

 

 4      Manual Stack manipulation
Load command stack file for OBS patch on Manual Sta ck

 

 Next Step:
  5

NOTE:
The current procedure assumes that the memory load is 
performed using commands with immediate execution.

 

Select the File -> LoadStack option from the main 
menu of the Manual Stack window

 

 

 4.1    IF
HIFI Prime
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Select file

HIDPRMPG_PI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/HIDPRMPG

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

HIDPRMPG_PI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 4.2    ELSE
HIFI Redundant

 

   

Select file

HIDPRMPR_PI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/HIDPRMPR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

HIDPRMPR_PI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 4.3    Check memory load command stack loaded 

 

   

Note:
The HIFI OBS image delivered in ICD-14 format consi sts 
of one block.
The block contains three segments:

- the runtime header starts at 0x00, length= 0x100
- the init-segemnt starts at 0x4000
- the PM-code segment.

The regions between segments are filled with 0x00.
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IMPORTANT:
A memory model (CT) shall be used to:
- avoid the useless patching of the areas between 
segments (filled with zeroes) 
- always patch ("Must be Patched") the runtime header 
memory area with the values in the Uplink Image (th e 
latest OBSM Reference image), irrespective of the 
comparison results of the Uplink Image against the 
Base Image (previous Reference Image or old OBS Dum p 
Image)

 

The patch sequence will be:
- upload the runtime header segment [0x00-0xFF] to PM-
High (+ 0x3FFFF)
- upload the differences between [0x4000 - EOF of 
Uplink Image] with respect to the Base Image to PM-
High (+ 0x3FFFF)

 

 

 4.3.1  Check number of memory load commands in the  stack 

 

   

Check that loaded stack contains one or more TCs 
XC000998.

 

 

 4.3.2  Check Memory ID

 

   

Display the Manual Stack in 'Full mode' and check t hat 
the Memory ID parameter in the XC000998 commands is 
set to 00 hex:

Memory ID = 00 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  HIFI Memory Load

Command Parameter(s) :
                     Memory ID            XH000998
                 Start Address            XH001998
               Length of Block            XH003998
       Var length octet string            XH004998
                      Checksum            XH005998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 30      
Det. descr. : Load HIFI Memory Using Absolute 
Addresses

      XC000998

00xx hex  
 <hex> (Def)
 <dec> (Def)
 <hex> (Def)
 <hex> (Def)

TC  

This Telecommand will not be included in the export

 

 4.3.3  Check start address of the memory load comm and(s) in 
the stack
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For HIFI OBS v.6.2.1:

The start address of the HIDPRMPG memory image used  
for memory load command stack generation is 00.0000 
hex, and the last address in the image is 01.852B hex.

The offset applied to the memory image for OBS upload 
in PM-High is 03.FFFF hex.

Consequently, the first address to be loaded is 
03.FFFF hex, and the last address is 05.852A hex:

Start Address = 03.FFFF hex
End Address   = 05.852A hex
Length        = 1852C hex

 

With the Manual Stack in 'Full mode', check that th e 
Start Address values in the XC000998 command(s) are 
within the range defined above.

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

 

 5      Upload commands to patch the HIFI OBS image  in PM-
High

 

 Next Step:
  6

Uplink the XC000998 memory load command(s) with ARM-GO  

For each TC XC000998 successfuly executed on-board,  a 
TM(1,1) and TM(1,7) packet shall be received on 
ground.

 

 

 5.1    IF
HIFI Prime

 

   

Verify Packet Reception

HIFI_TC_acceptance_OK
Packet Mnemonic :        H_Accepted
APID :                   1024
Type :                   1
Subtype :                1
PI1 :                    
PI2 :                    

Verify Packet Reception

HIFI_TC_execution_OK
Packet Mnemonic :        H_Completed
APID :                   1024
Type :                   1
Subtype :                7
PI1 :                    
PI2 :                    
 

 5.2    IF
HIFI Redundant
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Verify Packet Reception

HIFI_R_TC_acceptance_OK
Packet Mnemonic :        H_Accepted
APID :                   1025
Type :                   1
Subtype :                1
PI1 :                    
PI2 :                    

Verify Packet Reception

HIFI_R_TC_execution_OK
Packet Mnemonic :        H_Completed
APID :                   1025
Type :                   1
Subtype :                7
PI1 :                    
PI2 :                    
 

 6      Manual Stack manipulation
Load command stack file for OBS image ckeck on Manu al 
Stack

 

 Next Step:
  7

Note:
The whole HIFI DPU OBS image in the PM-High area is 
checked

 

Select the File -> LoadStack option from the main 
menu of the Manual Stack window

 

 

 6.1    IF
HIFI Prime

 

   

Select file

HIDPRMPG_CI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/HIDPRMPG

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

HIDPRMPR_CI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 6.2    ELSE
HIFI Redundant
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Select file

HIDPRMPR_CI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/HIDPRMPR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

HIDPRMPR_CI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 6.3    Check memory check command stack loaded 

 

   

Note:
The OBS image in PM-High is verified after load using 
checksum calculation over the following 3 memory 
areas:

For HIFI OBS v.6.2.1:

Start Address = 03.FFFF hex
End Address   = 04.00FE hex
Length        = 100 hex
Checksum      = TBC hex

Start Address = 04.3FFF hex
End Address   = 05.3FFD hex
Length        = FFFF hex

Checksum      = TBC hex

 

Start Address = 05.3FFE hex
End Address   = 05.852A hex
Length        = 452D hex
Checksum      = TBC hex

IMPORTANT:
# of TCs, Address and Length values in the following 
sub-steps are applicable to HIFI OBS v.6.1.2

 

Note:
The ' Length' parameter of the memory check command is 
a 16-bit long parameter. A memory check TC can cove r a 
number of 65535 dec ( FFFF hex) SAUs.

 

 

 6.3.1  Check number of memory check commands in th e stack

 

   

Check that loaded stack contains:
   3 TCs XC006998
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 6.3.2  Check Memory ID

 

   

Display the Manual Stack in 'Full mode' and check t hat 
the Memory ID parameter in the XC006998 commands is 
set to 00 hex:

Memory ID = 00 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                 HIFI Memory Check

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Check HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC006998

00xx <hex>  
 <hex> (Def)
 <hex> (Def)

TC  

 

 6.3.3  Check start address and length of first com mand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address in the first XC006998 command:

Start Address = 03.FFFF hex
Length        = 100 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                 HIFI Memory Check

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Check HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC006998

0003 <hex> 
FFFF <hex> 
100 <hex> 

TC  

 

 6.3.4  Check start address and length of second co mmand in 
the stack
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With the Manual Stack in 'Full mode', check  the Start 
Address in the second XC006998 command:

Start Address = 04.3FFF hex
Length        = FFFF hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                 HIFI Memory Check

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Check HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC006998

0004 <hex> 
3FFF <hex> 
FFFF <hex> 

TC  

 

 6.3.5  Check start address and length of third com mand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address in the third XC006998 command:

Start Address = 05.3FFE hex
Length        = 452D hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                 HIFI Memory Check

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Check HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC006998

0005 <hex> 
3FFE <hex> 
452D <hex> 

TC  

 

 7      Check OBS image in PM-High

 

 Next Step:
  8

For each TC(6,9), a TM(6,10) packet shall be receiv ed 
on ground.

 

IMPORTANT:
Address, Length and Checksum values in the following 
sub-steps are applicable to HIFI OBS v.6.1.2
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 7.1    Command and verify the first checksum

 

   

Uplink the first XC006998 memory check commands with 
ARM-GO

 

Execute Telecommand
                                 HIFI Memory Check

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Check HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC006998

0003 <hex> 
FFFF <hex> 
100 <hex> 

TC  

 

 7.1.1  Verify reception and contents of TM(6,10)

 

   

Note:
A TM(6,10) packet will be received for each memory 
check command uplinked.

 

 

 
7.1.1.1

 IF
HIFI Prime

 

   

Verify Packet Reception

HIFI_memory_check
Packet Mnemonic :        H_mem_check
APID :                   1024
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
               HI_check_mem_id            HM072190    = 00 hex AND=HA070289

Verify Telemetry
                HI_check_start            HM073190  = 3FFFF <hex> AND=HA070289

Verify Telemetry
               HI_check_length            HM074190  = 265 <dec> AND=HA070289

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 
7.1.1.2

 ELSE
HIFI Redundant
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Verify Packet Reception

HIFI_R_memory_check
Packet Mnemonic :        H_mem_check
APID :                   1025
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
               HI_check_mem_id            HM072190    = 00 hex AND=HA070289

Verify Telemetry
                HI_check_start            HM073190  = 3FFFF <hex> AND=HA070289

Verify Telemetry
               HI_check_length            HM074190  = 265 <dec> AND=HA070289

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 7.1.2  Verify checksum value

 

   

Check the received checksum against the expected va lue  

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 7.2    Command and verify the second checksum

 

   

Uplink the second XC006998 memory check commands with 
ARM-GO

 

Execute Telecommand
                                 HIFI Memory Check

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Check HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC006998

0004 <hex> 
3FFF <hex> 
FFFF <hex> 

TC  

 

 7.2.1  Verify reception and contents of TM(6,10)

 

   

Note:
A TM(6,10) packet will be received for each memory 
check command uplinked.

 

 

 
7.2.1.1

 IF
HIFI Prime
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Verify Packet Reception

HIFI_memory_check
Packet Mnemonic :        H_mem_check
APID :                   1024
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
               HI_check_mem_id            HM072190    = 00 hex AND=HA070289

Verify Telemetry
                HI_check_start            HM073190  = 4FFFF <hex> AND=HA070289

Verify Telemetry
               HI_check_length            HM074190  = 65535 <dec> AND=HA070289

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 
7.2.1.2

 ELSE
HIFI Redundant

 

   

Verify Packet Reception

HIFI_R_memory_check
Packet Mnemonic :        H_mem_check
APID :                   1025
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
               HI_check_mem_id            HM072190    = 00 hex AND=HA070289

Verify Telemetry
                HI_check_start            HM073190  = 4FFFF <hex> AND=HA070289

Verify Telemetry
               HI_check_length            HM074190  = 65535 <dec> AND=HA070289

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 7.2.2  Verify checksum value

 

   

Check the received checksum against the expected va lue  

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 7.3    Command and verify the third checksum

 

   

Uplink the third XC006998 memory check commands with 
ARM-GO
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Execute Telecommand
                                 HIFI Memory Check

Command Parameter(s) :
                     Memory ID            XH008998
                 Start Address            XH009998
                        Length            XH010998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 70      
Det. descr. : Check HIFI Memory Using Absolute 
Addresses
This Telecommand will not be included in the export

      XC006998

0005 <hex> 
3FFE <hex> 
452D <hex> 

TC  

 

 7.3.1  Verify reception and contents of TM(6,10)

 

   

Note:
A TM(6,10) packet will be received for each memory 
check command uplinked.

 

 

 
7.3.1.1

 IF
HIFI Prime

 

   

Verify Packet Reception

HIFI_memory_check
Packet Mnemonic :        H_mem_check
APID :                   1024
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
               HI_check_mem_id            HM072190    = 00 hex AND=HA070289

Verify Telemetry
                HI_check_start            HM073190  = 53FFE <hex> AND=HA070289

Verify Telemetry
               HI_check_length            HM074190  = 17709 <dec> AND=HA070289

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 
7.3.1.2

 ELSE
HIFI Redundant

 

   

Verify Packet Reception

HIFI_R_memory_check
Packet Mnemonic :        H_mem_check
APID :                   1025
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
               HI_check_mem_id            HM072190    = 00 hex AND=HA070289

Verify Telemetry
                HI_check_start            HM073190  = 53FFE <hex> AND=HA070289
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Verify Telemetry
               HI_check_length            HM074190  = 17709 <dec> AND=HA070289

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 7.3.2  Verify checksum value

 

   

Check the received checksum against the expected va lue  

Verify Telemetry
                   HI_data_crc            HM075190   AND=HA070289

 

 8      RETURN
to proc. H_FCP_HIF_CPOM

 

 Next Step:
  END

IMPORTANT:
After OBS image copy from PM-High to PM-Low execute d 
in H_FCP_HIF_CPOM, dump the HFI DPU new OBS image from 
PM-Low using FOP procedure H_FCP_OBS_3143

 

 

End of Sequence 

End of Procedure
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